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* The better the laser light is scattered (not reflected) back from the surface
of the target object and the brighter the laser point is in relation to the bright-
ness of the surroundings (interiors, twilight), the longer the range will be.
Under unfavourable conditions (e.g., measurement outdoors with strong
sunlight), it can be necessary to use a target panel.

** + 0.1 mm/m for distances over 30 m and for unfavourable conditions
such as, for example, strong direct sunlight

*** The transmission range can be influenced by environmental condi-
tions.  Walls made of or containing metal reduce the transmission range.

The serial number 
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 for positive identification of your unit is located on
the nameplate on the underside of the case.

The “Type-approval certificate under German law” is located at the end of
these operating instructions.

 

Product Specifications

 

Digital Laser Rangefinder DLE 150 Connect
PROFESSIONAL 

 

Article number 0 601 098 503

Measuring range (natural surfaces) 0.3 ... 150 m*

Measuring accuracy
Typical (0.3 ... 30 m)
Maximum

±2 mm
±3 mm**

Measuring time
Typical
Maximum

<0.5 s
4 s

Smallest display unit 1 mm

Operating temperature –10 °C ... +50 °C

Storage temperature –20 °C ... +70 °C

Laser type 635 nm, <1 mW

Laser class 2

Diameter of the laser beam (at 25 °C), 
approx.

at a distance of 10 m
at a distance of 50 m
at a distance of 100 m
at a distance of 150 m

6 mm
30 mm
60 mm
90 mm

Data interface (wireless) BLUETOOTH

 

®

 

 wireless 
technology class 2 
(Specification 1.1)

Transmission range, max. 10 m***

Batteries
Rechargeable batteries

4 x 1.5 V LR6 (AA)
4 x 1.2 V KR6 (AA)

Battery service life approx. 20000 single measurements

Automatic switch-off
Laser
Instrument (without measurement)

20 s
10 min

Weight in accordance with 
EPTA-Procedure 01/2003 0.43 kg

Protection class IP 54 (dust and splash water 
protection)
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System Requirements for the Transfer of the Measured Values
For the reception of the measured values, a PC or PDA with BLUETOOTH
wireless technology is required.

Requirements for the operating system:
– PC: Microsoft® Windows® 98 or a higher version
– PDA: Microsoft® Windows® Pocket PC 2002 or a higher version

For the installation of the “BOSCH DLE 150” software on a PC, it must
have a CD drive available.  If the measured values are to be received by a
PDA, then for the installation of the software on the PDA, a PC is neces-
sary with a CD drive as well as Microsoft® ActiveSync® 3.7 or a higher ver-
sion.

At www.bosch-imt.com, PCs and PDAs that are especially suitable for
working with the DLE 150 Connect are recommended.

The BLUETOOTH trademarks are the property of Bluetooth
SIG Inc., USA and licensed for Robert Bosch GmbH.

Microsoft, Windows, ActiveSync and Excel are trademarks or registered trade
names of the Microsoft Corporation in the USA and other countries.

The unit is intended for measuring distances, lengths, heights, spacings
and to calculate areas and volumes.  The unit is suitable for measuring in
interior and exterior construction.
The individual measured values can be transmitted wirelessly.

Please open the foldout page with the illustration of the unit and leave it
open while you read these operating instructions.

The numbering of the product elements refers to the illustration of the unit
on the graphic page.

1 Button for continuous/minimum/maximum measurement 

2 Length measurement button 

3 Bubble level A, B 

4 Aligning aid

5 Area measurement button 

6 “on/off” button

7 Button for measuring and data transmitting 
(Two-step button for aiming and measuring/transmitting)

8 Display

9 Display lighting button 

10 Continuous pointer mode button 

11 Volume measurement button 

12 Clear button 

13 Indirect length measurement button 

14 Button for memory recall/list of the last measured results 

15 Memory subtraction button 

16 Memory addition button 

17 Compact end pieceB 

18 Universal end pieceB 

Intended Use

Product Elements
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19 End piece latching

20 1/4" threads

21 Serial number

22 Receiving lens

23 Laser beam exit

24 Grip

25 Flap

26 Flap unlocking button

27 Positioning extension

28 Laser viewing glasses C 

29 Target panel C 

30 Optical sight ZO 4C 

31 Protective bagB 

32 Installation CD with the “BOSCH DLE 150” software for the data 
transmissionB 

A Located in the side pocket of the protective bag
B Accessory parts (included)
C Optional accessories (not included)

Display Elements
a Laser switched on

b Measurement functions

 Continuous/minimum/maximum measurement

 Length measurement

 Area measurement

 Volume measurement

 Indirect length measurement

c Minimum/maximum value

d Wireless connection indicator

e Individual measured values (except for length measuring function)

f Units of measure: m/m2/m3

g Measured value/results

h Display of previous measurement results

i Error indication

k Store/addition/subtraction of measured values

l Temperature indicator

m Battery indicator

n Measuring from the back end
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Working safely with this unit is possible only when
the operating and safety information are read com-
pletely and the instructions contained therein are
strictly followed.
SAVE THESE INSTRUCTIONS CAREFULLY AND EN-
SURE THAT THE WARNING LABELS ON THE IN-
STRUMENT ARE ALWAYS EASILY READABLE.

Do not point the laser beam at persons or animals
and do not look into the laser bean, even from longer
distances.

This measuring instrument produces laser radiation of the
laser class 2 according to EN 60825-1:2001. You can
therefore unintentionally blind other persons with it.

� Do not use the laser viewing glasses as protective glasses.  The
laser viewing glasses serve for better recognition of the laser beam,
however, they do not protect against the laser radiation.

� Do not use the laser viewing glasses as sun glasses or in street
traffic.  The laser viewing glasses do not provide complete UV protec-
tion and reduce colour perception.

� Have the measuring instrument repaired only by qualified spe-
cialist personnel and only with original replacement parts.  In
this manner, it is ensured that the safety of the instrument is main-
tained.

� Do not allow children to use the laser measuring instrument
without supervision.  They could unintentionally blind other persons.

� Protect the unit from moisture and direct sunrays.

� Dirt in the end piece can lead to corrosion or breaks in contact.  Always
keep the end piece clean.

� If the unit is not used for a long period, the batteries must be removed
(danger of corrosion).

� Transport and store the unit in the protective bag 31.

Use alkali-manganese or rechargeable batteries exclusively.

Rechargeable 1.2 V batteries reduce the number of possible measure-
ments.

Press the latches 19 on both sides of the end piece and remove the end
piece 17 or 18.

Insert the batteries provided. When inserting the batteries, pay attention
to the correct polarisation. Reinsert the end piece 17 or 18.

When the battery symbol  appears, at least 100 measurements are still
possible.

When the battery symbol blinks, the batteries must be replaced.  Meas-
urements are no longer possible.

Always replace the complete set of battery.

For Your Safety

Protection of the Unit

Inserting/Replacing the Batteries
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Switching On/Off
Switching on:
Press the “on/off” button 6 or the measurement button 7 completely
down.

Switching off:
Press the “on/off” button 6.

After approx. 10 min without performing a measurement, the unit switch-
es off automatically to save the batteries.

When automatically switched off, the current display and the settings of
the DLE 150 Connect are also stored in addition to the measured values.
However, an existing wireless connection is interrupted (see Sections In-
stalling the “BOSCH DLE 150” Software and Starting the “BOSCH DLE
150” Software).

When switched on again, the DLE 150 Connect is in the same functional
mode and shows the same display as before the automatic switch-off.  To
re-establish the wireless connection between the DLE 150 Connect and
the PC or PDA, see Section Wireless Connection.

Measuring Procedure
The instrument has several measuring functions that can be selected by
pressing the respective function button (see Measurement Functions
Section).  After switching on, the instrument is in the “Length Measuring”
function.

To change the measuring function, press the button for the desired func-
tion.  After selecting the measuring function, all further steps take place by
pressing the measure button 7.

Place the rear end of the unit (end piece) at the desired measuring position
(e.g. on a wall).  The rear end of the unit is the reference point for the
measurement.

– To switch on the laser beam, lightly press the measurement button 7
in the middle or press at the side.

– Aim at the target.
� Do not point the laser beam at persons or animals and do not

look into the laser bean, even from longer distances.
– To measure, press the measure button 7 completely down.

The measured value appears after 0.5 to 4 s.  The end of the measure-
ment is indicated by an acoustical signal.  The duration of the measure-
ment is dependent on the distance, light conditions and reflection charac-
teristics of the measured surface.  After completion of the measuring
procedure, the laser switches off automatically.

If a wireless connection exists to a PC or PDA, the last measured individ-
ual value is automatically transmitted after each measurement to the PC
or PDA (see Section Working with the “BOSCH DLE 150” Software ).

Continuous Pointer Mode
The unit can be switched to continuous laser beam (continuous pointer
mode) as required.  For this purpose, press the somewhat recessed con-
tinuous pointer mode button  10.  The laser beam will also remain
switched on between the measurements in this setting.  For measuring,
only a single complete pressing down of the measurement button 7 is
necessary.

Putting into Operation
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� Do not point the laser beam at persons or animals and do not
look into the laser bean, even from longer distances.

To switch off the continuous laser beam, press the continuous pointer
mode button  10 or switch off the unit.  After renewed switching on, the
unit is again in the normal mode (the laser beam is switched on only when
the measurement button 7 is pressed).

Installing the “BOSCH DLE 150” Software
The “BOSCH DLE 150” software delivered on the CD 32 makes possible
the transmission of the measured values to a suitable PC or PDA (see Sys-
tem Requirements for the Transfer of the Measured Values).

Depending on the operating system of the PC or PDA, administrator rights
may be necessary for the installation of  the software.

Installation on a PC
1. Start the PC and close unnecessary applications.

2. Place the installation CD 32 in the CD drive of the PC.

3. The selection menu of the “BOSCH DLE 150” software starts auto-
matically.  To start the installation, click on “Installing the Software”.

4. Follow the instructions of the Installation Assistant.

Installation on a PDA
1. Install the “BOSCH DLE 150” software on a PC that has Microsoft®

ActiveSync® available (see Installation on a PC).

2. Connect the PDA by means of Microsoft® ActiveSync® with the PC.
For this, see the operating instructions of the PDA.

3. The “BOSCH DLE 150” software is automatically transferred by Micro-
soft® ActiveSync® from the PC to the PDA as soon as it is connected
to the PC. Follow the instruction of the programs on the PC and the
PDA.

Starting the “BOSCH DLE 150” Software
1. Switch on the DLE 150 Connect.

2 Switch on the PC or the PDA with the “BOSCH DLE 150” software in-
stalled.

3. In the start menu of Microsoft® Windows® under “Programs”, click on
the “BOSCH DLE 150” program.

When working with a recommended PC
or PDA, the software attempts automat-
ically to make connection with all
switched on DLE 150 Connects that are
within range.  The progress of the search
process is indicated with a bar graph.

When working with a PC or PDA that is not one of those recommend-
ed, the connection must be made manually according to the instruc-
tions of the PC or PDA manufacturer.  In this case, use the “0000” PIN.
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The DLE 150 Connects found are dis-
played by the software.  The last six dig-
its of the serial number serve to distin-
guish between the individual units. The
serial number 21 can be found on the
nameplate on the underside of the unit.

5. Select and mark the desired unit on the basis of its serial number.  By
clicking on the “OK” button, the selection is acknowledged.
To perform a new search for available units, click on the “New Search”
button.

If a DLE 150 Connect was selected and
the selection acknowledged, a connec-
tion will be established to that unit (“Con-
nect the DLE 150 Connect” indication).
The display shown here then appears
with the serial number of the connected
DLE 150 Connect. The PC or PDA is
now ready to receive measured values.

The selection steps 4. and 5. are skipped when, at the start of the soft-
ware on the PC or the PDA, the DLE 150 Connect to which a wireless
connection last existed is within range.

Quitting the “BOSCH DLE 150” Software
To quit the software, select the “End” menu
item in the “File” menu on the menu bar.
This also interrupts the wireless connection.

The instrument measures from the back end of the case.

– The receiving lens and the outlet of the laser beam should not be cov-
ered during a measurement.

– For the wireless connection, it is not necessary that a line of sight ex-
ists between the DLE 150 Connect and the PC or PDA.  However,
transmission barriers (e.g. steel-reinforced concrete walls) reduce the
range.

Working Instructions

4.

6.
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– The DLE 150 Connect should not be moved during measurement (ex-
ception: the functions continuous/minimum/maximum measure-
ments).  For this purpose, rest the unit on or against the measuring
point, if possible.

– The measurement takes place at the middle point of the light spot,
also for obliquely illuminated target surfaces.

– The measuring range is dependent on the light relationships and the
reflection characteristics of the measured surface.  For working in ex-
terior areas and with strong direct sunlight, use the optical sight ZO 4
30, the laser viewing glasses 28 and the target panel 29 (accessory)
for better visibility of the laser point or shield the target surface.

– When measuring to transparent surfaces (e.g. glass, water) or reflect-
ing surfaces, erroneous measurement can result. Porous or struc-
tured surfaces, air strata with different temperatures or indirectly re-
ceived reflections can also influence the measured value.  These
effects are caused by physical properties and can therefore not be ex-
cluded by the measuring instrument.

– In the dark, press the display lighting button  9. The display is then
lit.  To switch off the lighting, press the  button 9 again.

– By means of the upper and side aligning aids 4, aiming over longer
distances is facilitated. For this purpose, sight along the upper or side
aligning aids.  The laser beam runs parallel to these lines of sight (see
Fig. ).

– When the DLE 150 Connect is switched off, all values in the memory
of the unit are retained.  However, when the end piece is removed
(changing of the end piece or the batteries), the memory contents are
lost.

– The instrument is equipped with a wireless interface.  Local operating
restrictions, for example in aircraft or hospitals are to be observed.

Changing the End Piece
The unit is provided with two different end pieces.

The compact end piece 17 reduces the dimensions of the unit.  It is suit-
able for measurements for which the rear end of the unit can rest on a flat
surface.

The universal end piece 18 is suitable for measurements from corners,
e.g. to determine the diagonals of a room.
– With the aid of the positioning extension 27 on the universal end piece

18, the unit can be placed on an edge (see Fig. ).  For this purpose,
pull up the flap 25 with the grips 24 and fold out the positioning ex-
tension 27.

– If the rear end of the unit is to be placed on a flat surface, fold in the
positioning extension 27.

– For measuring from corners, fold in the positioning extension 27,
press the unlocking button 26 and allow the flap 25 to relatch.

To change the end piece, press the latches 19 on both sides and remove
the end piece.  Insert the new end piece.

The unit takes automatically into consideration the different lengths of the
end pieces when measuring (measurement in both cases from the rear
end of the unit).

Bubble Level
The bubble level makes possible the easy horizontal alignment of the unit.

The bubble level 3 can be attached on the right or left of the display 8 on
the housing.  Attach the bubble level with the lower end of the holder first.

A

B
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Measurements with a Tripod
Measurements with a tripod are especially necessary for long distances.
The unit can be screwed onto a camera tripod with the 1/4" threads 20
on the underside of the housing.
� Also with the use of a tripod, the unit measures from its rear

end and not from the middle of the threads.

The distance from the threads 20 to the rear edge of the unit is 45 mm
with the compact end piece 17 and 70 mm with the universal end piece
18.

Measuring Long Distances
For the measurement of longer distances (>30 m), the use of the optical
sight ZO 4 30 and a tripod (accessory) is recommended.  With the optical
sight, the target area is shown enlarged four times and the visibility of the
laser point is improved by a swing-in filter.

General
Independent of the measuring function selected on the DLE 150 Connect,
individual measured values are transmitted wirelessly.  Values calculated
by the DLE 150 Connect (e.g. volume in m3) or stored values cannot be
transmitted.  Calculations on the basis of the transferred individual meas-
ured values are possible, however, with the aid of the applications on the
PC or PDA.

The last transferred measured value is displayed in each case by the
“BOSCH DLE 150” software.  In an opened application software on the
PC or PDA (e.g. Microsoft® Excel), this measured value is entered at the
same time at a desired location (see Inserting Measured Values in an Ap-
plication Software).

Indication Elements of the Software on a PDA

Online Help of the Software
The operating instructions can also be called up by means of the Online
Help of the “BOSCH DLE 150” software.

To use the Online Help, select the “Help”
menu item in the “Help” menu on the menu
bar.

Working with the “BOSCH DLE 150” Software

Status symbol

Status indicator of the wireless 
connection

Serial number of the connected 
DLE 150 Connect

Last transferred measured value

Menu bar
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Wireless Connection
During the start of the “BOSCH DLE 150” software, the wireless connec-
tion is established (see Starting the “BOSCH DLE 150” Software).

The software checks the status of the wireless connection regularly:

Wireless Connection Intact
When the connection is intact, the wireless
connection indication d appears on the dis-
play of the DLE 150 Connect and the status
indication shown here in the “BOSCH DLE
150” software.  On the PC or PDA, the sta-
tus symbol  is also visible while working
with other applications.

Disconnecting the Wireless Connection by the DLE 150 Connect
The wireless connection is interrupted when the DLE 150 Connect is lo-
cated out of range, when it is switched off or it switches itself off automat-
ically.

After an interruption, the software of the PC or PDA attempts to re-estab-
lish the connection for some minutes (“Connect the DLE 150 Connect” in-
dication).  In an application software, the status symbol  is shown in the
header during this time.

If the DLE 150 Connect is switched on again or returned to within range
during the time that the connecting process is running, the wireless con-
nection is then automatically re-established.

If the connection cannot be re-established
within some minutes, the status symbol of
the DLE 150 Connect is no longer displayed.
In the “BOSCH DLE 150” software, the dis-
play shown here appears.

To re-establish the connection to the same
DLE 150 Connect with which work was in
progress before the interruption, click on the
“Repeat” indicator.  The connection will be
re-established.

To start a search for all DLE 150 Connects
within range, click on “New Search”. All units
found will be listed. For the further proce-
dure, see Starting the “BOSCH DLE 150”
Software.

To close the software, click on “End”.

Disconnecting the Wireless Connection by the PC or PDA
When the software on the PC or PDA is terminated or it is located out of
range, the wireless connection indication d on the DLE 150 Connect then
goes off after a short time.

To re-establish the wireless connection, restart the “BOSCH DLE 150”
software on the PC or PDA.

Changing the Connection to Another DLE 150 Connect
To establish connection to another DLE 150
Connect, click on the “New Search” menu
item in the “File” menu on the menu bar.  All
units found will be listed.  For the further pro-
cedure, see Starting the “BOSCH DLE 150”
Software.
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Acquiring the Measured Values
The measured value transmitted by the DLE 150 Connect is always dis-
played in the “BOSCH DLE 150” software.  At the next measurement, the
value is overwritten.  In addition, the transmitted measured value can be
entered in another application software at the same time when this soft-
ware was started before the measurement.

Processing Measured Values in the “BOSCH DLE 150” Software
The currently displayed measured value can transferred to the clipboard
of the PC or PDA and entered in other programs as required.

To cut out, copy or delete the measured val-
ue, select the corresponding menu item in
the “Edit” menu on the menu bar.

Inserting Measured Values in an Application Software
The measured values transmitted by the DLE 150 Connect can be en-
tered directly in any software (e.g. Microsoft® Excel).  For this purpose,
start the application software on the PC or PDA and open the file in which
the measured values are to be inserted.  Place the cursor at the location
at which the next measured value is to be entered.  Then perform the
measurement.  The measured value is inserted at the position marked by
the cursor.

Example:
On a PDA in the Microsoft® Excel program,
the table cell E19 (shown here) was select-
ed.  The value 23.35 m was then measured
with the DLE 150 Connect.  This value is au-
tomatically entered in the selected table cell
E19 and is available there for further calcula-
tions.

Switching from the Application Program to the “BOSCH DLE 150”
Software
By means of the  status symbol in the menu bar, it is possible to switch
to the “BOSCH DLE 150” software at any time.  The last transmitted
measured value can be checked here.
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Options for Working with the Measured Values
In the “Options” menu of the “BOSCH DLE
150” software, the format of the displayed
measured values as well as the type of their
acknowledgement can be defined.  In this
manner, the format for the display of the
measured values in the Software is defined
but the display on the DLE 150 Connect re-
mains unchanged. 

For the selection of the options, click on the
respective menu item.  The current selection
is marked in the menu with a check mark.

Acknowledgement of the measured values: For the use of the indi-
vidual measured values in an application software, the type of acknowl-
edgement can be defined.
– Manual acknowledgement: With manual acknowledgement, the

measured value is overwritten on the PC or PDA until it is manually ac-
knowledged (e.g. by pressing the arrow buttons).  In this manner, a
measurement can be repeated until the correct (desired) measured
value is present.

– Automatic acknowledgement:  With automatic acknowledgement,
a return (“Enter”) is automatically inserted after each measured value.
This option makes possible that, for example in Microsoft® Excel, the
data of several measurements can be written consecutively in a col-
umn without having to separately acknowledge each measured value.

Selection of the measuring unit: The measured values can be dis-
played in the measuring units of m, cm or mm.

Selection of the decimal point: As the decimal point for the display of
the measured values, a coma (“##,###”, e.g. 23,35 m) or a period
(“##.###”, e.g. 23.35 m) can be selected.

Length Measurements
Press the length measuring button  2 to switch to the mode for length
measurements. The symbol for length measurements appears in the up-
per part of the display.

To measure, press the measure button 7
completely down.
The measured value is shown at the bottom of
the display and transmitted automatically at
the same time.

Area Measurement
Press the area measuring button  5 to switch to the mode for area
measuring. The symbol for area measurements appears in the upper part
of the display.

Then measure the length and width one after
the other as for a length measurement.  The
individual values are transmitted automatical-
ly.  After completion of the second measure-
ment, the result is automatically calculated
and displayed but not transmitted.

The individual measured values are shown in
the upper right of the display, the results at the
bottom.

Measurement Functions
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Volume Measurement
Press the volume measuring button  11 to switch to the mode for vol-
ume measurement. The symbol for volume measurement appears in the
upper part of the display.

Then measure the length, width and height
one after the other as for a length measure-
ment.  The individual values are transmitted
automatically.  After completion of the third
measurement, the result is automatically cal-
culated and displayed but not transmitted.

The individual measured values are shown in
the upper right of the display, the results at the
bottom.

Continuous/Minimum/Maximum Measurement
Switching between the continuous, minimum and maximum measure-
ment functions is performed by repeated pressing of the  button 1.

Continuous Measurement (see Fig. )
The continuous measurement serves for the transfer of dimensions, for
example, from construction plans.  With continuous measuring, the instru-
ment can be moved relative to the target with the measured value being
updated approximately every 0.5 s.  For example, the user can move
back from a wall until he reaches the desired distance with the actual dis-
tance always being readable.

To switch to the continuous measuring mode, press the  button 1 re-
peatedly until the  symbol as well as the “MIN.” and “MAX.” indicators
appear in the display.

To initiate the measurement process, press
the measurement button 7 completely down.
Move the measuring instrument until the de-
sired distance value is shown at the bottom of
the display.

By pressing the measurement button 7, the
continuous measuring is interrupted.  The cur-
rent measured value is shown in the display
and automatically transmitted.  A repeated
pressing of the measurement button 7 starts
the continuous measurement anew.

The continuous measuring switches off automatically after 10 min.  The
last measured value remains in the display.
For earlier ending of the continuous measuring, change the measuring
function with one of the function buttons.

C
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Minimum Measurement (see Fig. )
The minimum measurement serves for determining the minimum distance
from a fixed reference point.  It is an aid, for example, for the determination
of a vertical or horizontal distance.  For minimum measuring, use the uni-
versal end piece 18.

To switch to the minimum measuring mode, press the   button 1 re-
peatedly until the  symbol as well as the “MIN.” indicator appear in the
display.

To initiate the measurement process, press
the measurement button 7 completely down.
Move the laser spot back and forth over the
desired target point (e.g. a wall) such that the
rear end of the unit as the reference point of
the measurement remains at the same posi-
tion.

The minimum measured value is shown in the
upper right of the display.

By pressing the measurement button 7, the minimum measuring is end-
ed.  The current measured values as well as the minimum value are shown
in the display.  The minimum value is automatically transmitted.  A repeat-
ed pressing of the measurement button 7 starts the minimum measure-
ment anew.

Maximum Measurement (see Fig. )
The maximum measurement servers for the determination of the maxi-
mum distance from a fixed reference point.  It is an aid, for example, for
the determination of diagonals.  For maximum measuring, use the univer-
sal end piece 18.

To switch to the maximum measuring mode, press the  button 1 re-
peatedly until the  symbol as well as the “MAX.” indicator appear in the
display.

To initiate the measurement process, press
the measurement button 7 completely down.
Move the laser spot back and forth over the
desired target point (e.g. corner of a room)
such that the rear end of the unit as the refer-
ence point of the measurement remains at the
same position.

The maximum measured value appears in the
upper right of the display.

By pressing the measurement button 7, the maximum measuring is end-
ed.  The current measured values as well as the maximum value are
shown in the display.  The maximum value is automatically transmitted.  A
repeated pressing of the measurement button 7 starts the maximum
measuring anew.

D

E
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Indirect Length Measurement (see Fig. )
The indirect length measuring function serves for measuring distances
that cannot be measured directly because an obstacle would obstruct the
laser beam or no target surface is available as a reflector.  The best pos-
sible results are achieved only when the laser beam and the measured
distance form an exact right angle (Pythagorean theorem).

In the illustrated example, the length “C” is to be determined. For this pur-
pose, “A” and “B” must be measured.

Press the indirect length measurement button  13 to switch to the
mode for indirect length measuring. The symbol for indirect measuring 
appears in the display.

As for a length measurement, measure the
distance “A”.  Take care that a right angle ex-
ists between the laser beam and the distance
“C”.  Then measure distance “B”.

During the measurements, the rear end of the
unit as the reference point must remain at the
same position.

The individual measured values “A” and “B” are shown at the upper right
and are automatically transmitted after each measurement.

After completion of the second measurement, the length “C” is automat-
ically calculated by the DLE 150 Connect and shown at the bottom of the
display.  The “C" value is not transmitted.

Clearing the Measured Values
By pressing the  clear button 12, the correction of the last deter-
mined individual measured value is possible.

By repeated pressing of the clear button
, several individual measured values are

cleared one after the other in the reverse order
of the measurement.

By pressing the  clear button in the con-
tinuous measurement functional mode, the
minimum and maximum measured values are
both cleared at the same time.

Already transmitted measured values must be cleared in the “BOSCH
DLE 150” software or in the application software used (see Working with
the “BOSCH DLE 150” Software).  The clearing is not possible by means
of the DLE 150 Connect.

Storing the Measured Values
The unit makes possible the storing of the measured values by two meth-
ods:
– Adding/subtracting measured values: The results of individual

measurements can be added or subtracted and the sum or difference
displayed.

– List of the last 20 measured results: In addition, the unit stores au-
tomatically the results of the last 20 measurements and can display
them.

Both methods of storing are called up with the memory recall button
 14.

The transmission of stored measured values is not possible.  If transmitted
measured values are to be added or subtracted, this must take place in
an application software on the PC or PDA.

F
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Adding/Subtracting Measured Values
Storing/Adding Measured Values

By pressing the  button 16, the value at
the bottom of the display – either a length,
area or volume value depending on the cur-
rent measuring function – is stored in memory.
In the display, “M+” appears briefly and then
“M”.

If a value is already present in the memory, the
new value is added to the memory contents,
however, only when the units of the measure-
ments are in agreement.

For example, if an area value is stored in the memory and the current
measurement is a volume value, the addition cannot be performed.  In the
display, the “ERROR” message blinks briefly.

Subtracting Measured Values
By pressing the  button 15, the value at the bottom of the display is
deducted from the value stored.  In the display, “M–” appears briefly and
then “M”.

If a value is already stored in memory, the new value is subtracted from
the contents of memory, however, only when the measuring units agree
(see Storing/Adding Measured Values).

Displaying Stored Values
By pressing the button for memory recall

 14, the value stored in the memory is
displayed.  In the display, the memory symbol
“M=” appears.

When the memory content “M=” is shown in
the display, it can be doubled by pressing the

 button 16 or set to zero by pressing the
 button 15.

Clearing the Memory
To clear the memory contents, first press the  button 14 for memory
recall until “M=” appears in the display.  Then press the clear  but-
ton 12; the “M” no longer appears in the display.

List of the Last 20 Measured Results
Displaying the List

By repeated pressing of the memory recall
button  14, the last 20 measured results
are displayed in reverse order (the last meas-
ured value first).  In the display, the symbol 
appears.  The counter on the right next to the
symbol  shows the numbering of the meas-
urements.

The measured values displayed can still be entered into memory by press-
ing the  button 16 or the  button 15.

Clearing the List
The list of the last 20 measurement results can be cleared when first the

 button 14 for memory recall is pressed until the  symbol and the
counter of the measurements appear.  Then press the clear  button
12; in the display,  no longer appears.
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The instrument monitors the correct functioning for
every measurement.  If a defect is detected, only the
symbol  blinks in the display (measurement from the
back end). Take the unit to your dealer for sending to
the Bosch customer service.

Error – Cause and Correction

Cause Correction

The temperature indicator l blinks, measuring is not possible

Measurement outside the allowed
temperature range from –10 °C to
+50 °C.

Wait until the allowable temperature
range is reached.

“ERROR” Message and “------- m” in the Display

The angle between the laser beam
and the target is too acute.

Increase the angle between the
laser beam and the target.

The target surface reflects too
strongly (e.g. a mirror) or too weak-
ly (e.g. black material).

Use the target panel (accessory).

Ambient light is too strong 
(e.g. sunlight).

Use the target panel (accessory).

The receiving lens 22 or the laser
beam exit 23 are misted over, for
example, as a result of changing
between low and high environmen-
tal temperatures.

Wipe the receiving lens 22 or the
laser beam exit 23 dry with a soft
cloth.

Unreliable Measurement Results

The target surface does not reflect
clearly (e.g. water, glass).

Cover the target surface.

The laser beam exit 23 or the
receiving lens 22 is soiled.

Keep the laser beam exit 23 or the
receiving lens 22 free of dirt.

A wireless connection is not established or is interrupted

The DLE 150 Connect or PC/PDA
is switched off or the software was
not started.

Check whether the DLE 150
Connect and PC or PDA is
switched on and the “BOSCH DLE
150” software started on the PC or
PDA.

The distance between the DLE 150
Connect and PC or PDA is too
large.

Reduce the distance between the
DLE 150 Connect and the PC or
PDA.

Environmental influences interfere
with the wireless connection.

Remove the DLE 150 Connect and
PC or PDA from the vicinity of pos-
sible interference sources (e.g.
walls made of or containing metal).

The PC or PDA used is not sup-
ported by the “BOSCH DLE 150”
software.

Information concerning the equip-
ment recommended by Bosch can
be found at www.bosch-imt.com.

The version of the “BOSCH DLE
150” software is not current.

Download a software update at
www.bosch-imt.com.

The corrective measures listed
above do not eliminate the error.

Take the unit to your dealer for
sending to the Bosch customer
service.
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The accuracy of the instrument can be checked as follows:
– Select a distance that never changes that is approx. 1–10 m long

(e.g. room width, door opening) whose length is known exactly.
– Measure this distance ten times one after the other.

The measurement error can be a maximum of ±3 mm.  Record the meas-
urements so that the accuracy can be compared at a later time.

Do not immerse the unit in water.

Wipe off dirt with a damp, soft cloth.  Do not use aggressive cleaning
agents or solvents.

Take care of the unit, especially the receiving lens 22, by handling it in the
same manner as for eye glasses or a camera.

If the unit should fail despite the care taken in manufacture and testing,
repair should be carried out by an authorised customer services agent for
Bosch power tools.

For all inquiries and replacement parts ordering, always include the 10-
place article number on the nameplate of the unit.

In the “Help” menu of the “BOSCH DLE 150” software, the installed ver-
sion of the software is shown under the “Info” menu item.

In case of repair, send in the unit in the protective bag 31.

Recycle raw materials instead of disposing as waste.
The unit, accessories and packaging should be sorted for environment-
friendly recycling.

These instructions are printed on recycled paper manufactured without
chlorine.

The plastic components are labeled for categorized recycling.

Do not throw used batteries into household waste, fire or water, but rather
– according to the applicable legal regulations – dispose of in an environ-
mentally friendly manner.

Checking the Measurement Accuracy

Maintenance and Cleaning

Environmental Protection



English–191 609 929 F53  •  (04.07) T

Exploded views and information on spare parts can be found under:
www.bosch-pt.com.

Great Britain
Robert Bosch Ltd. (B.S.C.)
P.O. Box 98
Broadwater Park
North Orbital Road
Denham-Uxbridge
Middlesex UB 9 5HJ

✆ Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+44 (0) 18 95/83 87 82
✆ Advice line . . . . . . . . . . . . . . . . . . . . . . . . . . .+44 (0) 18 95/83 87 91
Fax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+44 (0) 18 95/83 87 89

Ireland
Beaver Distribution Ltd.
Greenhills Road
Tallaght-Dublin 24

✆ Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+ 353 (0)1/414 9400
Fax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+ 353 (0)1/459 8030

Australia
Robert Bosch Australia L.t.d.
RBAU/SBT2
1555 Centre Road
P.O. Box 66 Clayton
3168 Clayton/Victoria

✆ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+61 (0)1/800 804 777
Fax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+61 (0)1/800 819 520
www.bosch.com.au
E-Mail: CustomerSupportSPT@au.bosch.com

New Zealand
Robert Bosch Limited
14-16 Constellation Drive
Mairangi Bay
Auckland
New Zealand

✆ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  +64 (0)9/47 86 158
Fax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+64 (0)9/47 82 914

Further information on Bosch measuring instruments can be found at
www.bosch-imt.com.

Specifications subject to change without notice

Service and Customer Advice


